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11.1. CAD per dispositivi elettronici 
 

La progettazione CAD è presente in molte aree industriali. Progettazione CAD 
significa che utilizziamo gli strumenti delle tecnologie dell'informazione IT nel processo 
di progettazione. La progettazione CAD comprende hardware, software specifico e 
dispositivi esterni e interfacce. Il nucleo del design CAD è il pacchetto di programmi che 
utilizza la grafica per la visualizzazione, diversi datasocket e driver per periferiche. La 
progettazione CAD non modifica il processo di progettazione, ma lo facilita e accelera in 
modo significativo. Questi strumenti sono molto efficienti soprattutto nella 
progettazione di dispositivi che devono essere ecologicamente efficienti. Molti 
strumenti contengono già elementi che consentono di analizzare e valutare se il design 
è ecologico. Alcuni strumenti contengono anche datasockets con elementi e materiali 
che fanno parte del design. L'essenza del design CAD è riassunta nei seguenti punti: 

• Precisa presentazione grafica del prodotto. È anche più facile analizzarlo, 
modificarlo o aggiornarlo.Enables complex design in very short time.  

• Consente la simulazione di diversi eventi, come elettrico, chimico, termico 
e meccanico. 

• Con gli strumenti di simulazione, è più facile fornire un approccio ottimale 
alla progettazione e al prodotto stesso. 

I primi strumenti CAD sono stati sviluppati per l'industria spaziale e 
automobilistica. In seguito, si sono estesi ad altre aree di progettazione, come l'industria 
elettronica e tessile, l'imballaggio, ecc. 

Gli strumenti CAD sono stati pensati originariamente per l'automatizzazione dei 
processi di progettazione e modellazione di sistemi. I moderni strumenti CAD 
supportano la maggior parte delle attività in fase di progettazione. Contengono 
informazioni sulle caratteristiche del prodotto e sui materiali utilizzati. Questi strumenti 
fungono anche da piattaforma comune per lo scambio di dati tra diversi gruppi di 
progettazione e team. Possono contenere informazioni sulla produzione e sono spesso 
denominati strumenti CAD / CAM (produzione assistita da computer). L'immagine 1 
presenta il processo di progettazione ordinaria e CAM / CAD. Lo strumento CAD riduce i 
tempi di progettazione, il che significa che il prodotto sarà disponibile sul mercato in un 
periodo di tempo più breve e lo sviluppo del prodotto sarà più economico. Gli strumenti 
CAD consentono inoltre di salvare il processo di progettazione, consentendo un 
aggiornamento più rapido e semplice della versione iniziale. L'immagine 2 presenta il 
tempo medio trascorso per la progettazione del prodotto e il suo utilizzo. Più il tempo 
di progettazione è breve, più lunga è l'utilità del dispositivo sul mercato. Questa 
condizione è valida solo se il design è eseguito correttamente. 
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IMMAGINE 1: ESEMPIO DI DESIGN CLASSICO E CAD/CAM. 

 

 

IMMAGINE 2: TEMPO MEDIO DI PROGETTAZIONE E USO DEL PRODOTTO. 

 

Nel prossimo capitolo verranno presentati gli strumenti CAD destinati alla progettazione 
di dispositivi elettronici. 
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11.2.  Progettazione di circuiti stampati  
 

La progettazione di circuiti stampati PCB è il compito chiave di ogni processo di 
sviluppo. Il circuito ben progettato e la stampa stessa influenzano la qualità e 
l'affidabilità del dispositivo. Con il processo di progettazione, si determinano tutti gli 
elementi e le dimensioni del circuito. Quando si scelgono componenti e dimensioni del 
materiale stampato, si possono soddisfare molte linee guida ecologiche. Di solito, 
vengono utilizzati componenti di dimensioni ridotte, consumano meno energia e  circuiti 
di progettazione che richiedono meno spazio. Oggi conosciamo molte tecnologie 
avanzate che consentono di stampare su più livelli. Questi consentono una superficie 
del circuito più piccola e di conseguenza un minor consumo di materiale. D'altra parte, 
la tecnologia di produzione è molto più costosa e utilizza più energia, il che la rende 
meno eco-compatibile. Quando progettiamo stampati, dobbiamo trovare un 
compromesso tra gli elementi scelti e le dimensioni del materiale stampato che avrà un 
impatto ecologico inferiore nella fase di produzione. Oltre a questi aspetti, dobbiamo 
prendere in considerazione alcune linee guida e regolamenti sulla progettazione di 
materiale stampato con l'intento di ottenere un'elevata affidabilità e qualità dei 
materiali stampati e del dispositivo finale. 

Gli standard per la progettazione di materiale stampato sono monitorati 
dall'associazione IPC che gestisce la standardizzazione della produzione di materiale 
stampato e l'uso del materiale. Il documento principale che riguarda la progettazione 
dei circuiti stampati è il documento ICP-2221 - Generic Standard on Printed circuit Board 
Design.. 

I passaggi standard nella progettazione di materiale stampato sono: 

• Specifiche del progetto.  

• Progettazione di schemi elettrici.  

• Progettazione del circuito.  

• Prototipizzazione. 

• Analisi. 

• Produzione. 

Attualmente, ci sono molti strumenti sul mercato che consentono la progettazione 
di circuiti stampati. Ecco alcuni di quelli più usati:  

• AutoTRAX (Schema, progettazione PCB con simulatore Spice integrato) 

• Advanced Design System (destinato all'elettronica RF: telefoni cellulari, 
rete WiFi, comunicazione satellitare, radar, circuito VF - simulatori VF)  

• Eagle (Schema, progettazione PCB, versione gratuita disponibile per 
progetti più piccoli, ambiente accademico, visualizzazione 3D, ecc.).  

• Altium designer (schemi, PCB, supporto per FPGA - Field Programmable 
Gate Array, con opzione di programmazione,  visualizzazione 3D) 

• OrCAD tools (Schemi, PCB)  
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• CADSTAR (Schema, diagrammi, PCB, versione gratuita disponibile con 
funzioni di base CADSTAR Express)  

• KICAD (ambiente a codice aperto, schema, PCB e visualizzazione 3D) 

 

11.2.1 Progettare schemi elettronici 

 

Quando si progettano schemi elettronici, è importante che lo schema sia 
organizzato e che vi siano relazioni logiche. Un buon schema è anche progettato in modo 
molto simile al materiale che verrà stampato. Ad esempio, se si vuole posizionare un 
condensatore vicino a un determinato componente elettronico, lo si disegna anche nello 
schema vicino al simbolo o al componente. Ci atterremo alla regola non scritta che tutti 
gli input sono sulla sinistra e tutti gli output sul lato destro dello schema. Se necessario, 
utilizzeremo anche commenti e note. Nei circuiti complessi, definiremo le aree dello 
schema in modo da migliorarne la visibilità. Tutte le aree insieme costituiscono lo 
schema completo del dispositivo. Le aree sono solo sezioni di schema virtuali che 
arrotolano le parti dei circuiti. Ad esempio, disegniamo la parte dell'alimentatore 
separatamente o su una certa area dello schema. La parte di controllo è anche 
progettata sulla propria area, ecc. L'immagine 3 presenta lo schema classico per la 
progettazione di circuiti stampati. 

 

 

IMMAGINE 3: SCHEMA PER LA PROGETTAZIONE DI UNA SCHEDA DEL CIRCUITO STAMPATO. 
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11.2.2 Progettazione di circuiti stampati  

Altrettanto importante è fare lo schema per il passo successivo nella produzione 
di materiale stampato. La progettazione dei circuiti stampati consiste nella disposizione 
degli elementi e nelle connessioni tra di essi. Con la produzione di stampati, 
determiniamo l'aspetto finale degli stampati. Nella produzione, è molto importante 
utilizzare le librerie di elementi. In questi, possiamo trovare le caratteristiche e le 
dimensioni dell'elemento, nonché i nomi dei morsetti collegati. Nella produzione di 
materiale stampato dobbiamo considerare le seguenti regole: 

• Scelta del materiale stampato (materiale, larghezza). 

• Numero di strati di materiale stampato. 

• Disposizione dei livelli. 

• Disposizione dei circuiti su stampati. 

• Considerazione degli impatti parassiti.  
La disposizione dei componenti su stampati. 

 

IMMAGINE 4: CIRCUITI STAMPATI - PCB. 

 

Nella produzione di circuiti stampati, spesso si incontrano sistemi metrici diversi. 
I componenti elettronici di solito hanno dimensioni e disposizione di piedini di 
collegamento presentati in unità di pollice. n Europa, vengono utilizzate più spesso le 
unità metriche. L'unità in pollici viene utilizzata per le dimensioni di connessioni, 
connettori in rame e pad. Le unità metriche vengono utilizzate per determinare la 
dimensione del foro, le dimensioni del materiale stampato e le dimensioni 
dell'alloggiamento del circuito. 

 
Linee di rame 

Lo spessore della linea di rame viene scelto in base alle esigenze elettriche e allo 
spazio stampato. Le linee più spesse danno risposte più veloci e risultati migliori. Linee 
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più larghe e più spesse hanno una resistenza inferiore e una lunghezza più corta, la loro 
produzione è più facile ed economica, sono più facili da riparare ed esaminare. Quando 
si sceglie il produttore di circuiti stampati, è necessario sapere quali sono le linee più 
vicine e le distanze più piccole che il produttore può ancora fornire. 

Ad esempio, offrire 10/8 significa che i barattoli delle linee possono essere di 
almeno 10 mil di larghezza e la distanza tra loro può essere di almeno 8 mil. Le offerte 
tipiche sono 10/10 o 8/8. Generalmente, gli stampati con 12/12 possono essere prodotti 
da quasi tutti i produttori. Lo standard IPC consiglia il limite più basso fino a 4/4. Distanze 
più piccole possono significare che i costi di produzione di materiale stampato sono 
significativamente più alti. Un esempio di buona pratica dell'uso di una linea più ampia 
e del suo restringimento nei punti in cui è necessario è presentato nell'immagine 5. In 
questo modo, possiamo mantenere un'impedenza totale inferiore.  

 

IMMAGINE 5: ESEMPIO DI LINEA STRETTA . 

La larghezza e la lunghezza del filo sono determinate dalla corrente elettrica e dalla 
frequenza del segnale elettrico. Per correnti più elevate, si consiglia di utilizzare come 
linee spesse il più possibile. Linee più strette hanno una maggiore resistenza, che causa 
perdite e riscaldamento indesiderato dei conduttori. La seguente tabella 1 presenta la 
larghezza della linea consigliata in base alla corrente con un aumento di temperatura di 
10 ° C.   

 

 Larghezza linea preferita (mil) 1mil=0.0254mm 
Corrente [A] 1oz  larghezza (µm) 2oz larghezza (µm) 

1 350 175 
2 1050 525 
3 1750 875 
4 2800 1400 
5 3850 1925 
6 5250 2625 
7 6300 3150 
8 7700 3850 
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9 9100 4550 
10 10500 5250 

TABELLA 1: LARGHEZZA DELLA LINEA DI RAME IN CIRCUITI STAMPATI DA CORRENTE. 

La resistenza del filo di rame è calcolata con la formula:  

𝑅 =
𝜌𝐶𝑢𝑙

𝑆
,   𝜌𝐶𝑢 = 1.724 × 10−6Ω𝑐𝑚, 

Dove R è laresistenza, lunghezza L, sezione trasversale S e resistività di rame 
specifica 𝜌𝐶𝑢 . La lunghezza della linea è condizionata dalla frequenza del segnale 
prevista. Esempio di buona pratica fornisce una stima sulla lunghezza della linea in base 
alla frequenza del segnale: 

𝐿 =
1

20
𝜆 =

1𝑐

20𝜐
 , 

dove L è la lunghezza della linea ammissibile, λ è la lunghezza d'onda, υ è la 
frequenza d'onda, c è la velocità della luce. Nei segnali ad alta frequenza, la condizione 
non può essere soddisfatta, quindi è necessario considerare il tempo di propagazione 
del segnale sulla linea data, che causa un ritardo di tempo. Nei conduttori paralleli, è 
importante che siano più corti e di lunghezza uguale. La maggior parte dei pacchetti di 
programmi corregge le lunghezze dei conduttori critici. Alle linee ad alta frequenza, 
evitiamo anche i connettori RF, che causano disturbi e perdita di segnale. 

Accesso Verticale di Interconnessinoe 

Le VIA sono linee di rame metallizzate con diversi strati. Sono molto simili ai pad 
di connessione con cui non vanno confusi. Il pad di connessione fa parte del socket del 
componente e VIA collega solo le connessioni tra diversi strati di materiale stampato. 
L'immagine 6 presenta VIA in materiale stampato multistrato 

 

IMMAGINE 6: VIA IN MATERIALE STAMPATO MULTISTRATO. 

Poligoni 

I poligoni vengono utilizzati per riempire aree più grandi con una trama di rame o 
rame pura, come mostrato nell'immagine 7. I poligoni sono interconnessi dai pad di 
connessione e dai VIA. Solitamente, sono usati per sostituire le basi di messa a terra e di 
alimentazione. Li installeremo alla fine dopo che tutte le altre linee di rame sono già 
state tracciate. 
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a)                                                                                            b) 

IMMAGINE 7: POLIGONI STAMPATI; A) STRATO SUPERIORE, B) TEXTURE IN RAME. 

 

Quando si tracciano poligoni e linee, è necessario considerare lo spazio vuoto tra 
le linee o il poligono. Meglio non avere distanze troppo ravvicinate perché possono 
causare cortocircuiti sulla linea sottile che possono verificarsi in fase di produzione. 
Dobbiamo anche considerare il limite inferiore per la produzione di stampati. Dipende 
dal produttore e dalla tecnologia di produzione. La regola comune è 15 mil per i 
componenti del filo e da 8 a 10 mil come limite inferiore per gli elementi montati sulla 
superficie. Per i circuiti che funzionano a una tensione di rete di 230 V / 110 V, è 
necessario considerare gli standard di sicurezza validi per una determinata area 
geografica. La regola di base è che tra fase e corrente zero deve esserci una distanza di 
almeno 3,2 mm. La distanza minima tra parti ad alta tensione e parti con le quali l'utente 
può entrare in contatto è di 8 mm. Una semplice linea guida è che le distanze dovrebbero 
essere il più ampie possibile rimanendo all'interno delle dimensioni concesse! 

Per dimensioni, dobbiamo anche considerare l'isolamento galvanico. Queste 
distanze sono definite dallo standard IPC. Le distanze variano a seconda che si trovino 
all'interno o all'esterno di stampati e dell'area in cui verrà utilizzato il componente 
elettronico (ambiente umido, altitudine, ecc.). Spesso proteggiamo il materiale 
stampato con un rivestimento laccato che aumenta la resistenza alla corrosione 
galvanica e protegge il circuito dagli effetti esterni. La Tabella 2 presenta le distanze e gli 
strati standard per i diversi componenti di un circuito stampato per tensione. 
L'isolamento galvanico è determinato dalla tensione di rottura. La forza di rottura è una 
caratteristica materiale che è data dalla seguente formula: 

𝐸𝑝 =
𝑈𝑝

𝑑
    [

𝑉

𝑚
], 

dove 𝐸𝑝 è la forza di sfondamento elettrica, la tensione elettrica 𝑈𝑝 e d è una dimensione 

isolante. Isolanti diversi presentano diverse resistenze elettriche, riportate nella tabella 3.  
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Tensione Strati interni Conduttori esterni non 
rivestiti 

Conduttori esterni 
rivestiti 

[V] [mm] [mm] [mm] 

15 0.05 0.1 0.05 
20 0.05 0.1 0.05 
50 0.1 0.6 0.13 

100 0.1 0.6 0.13 
150 0.2 0.6 0.4 
170 0.2 1.25 0.4 
250 0.2 1.25 0.4 
300 0.2 1.25 0.4 
500 0.25 2.5 0.8 

1000 1.5 5 2.33 
4000 9 20 11.48 
5000 11.5 25 11.53 

TABELLA 2: DISTANZE PRESCRITTE PER L’ISOLAMENTO GALVANICO DELEL LINEE MATERICHE STAMPATE. 

 

 

Isolante (20C̊) 
𝐸𝑝  [

𝑉

𝑚
] × 106 

Aria 3 
Carta 10 

Gomma 10 
Olio trasformatore 15 

Porcellana 20 
Cloruro di Polivinile-PVC 50 

Polistirolo 80 

TABELLA 3: RESISTENZA ELETTRICA DI ALCUNI MATERIALI. 

 

Regole di base per il collegamento di componenti di materiale stampato 

La connessione di componenti implica l'installazione di linee di rame su materiale 
stampato tra i connettori dei componenti. Le connessioni elettriche tra due o più pad di 
connessione sono chiamate rete di segnali elettrici. Cerchiamo una rete di segnali 
elettrici più corti perché linee più lunghe causano effetti parassiti più gravi. Le linee 
dovrebbero rompersi a 45 °, oppure possiamo usare linee arrotondate. Le linee in rame 
sono collegate al centro dei pad di connessione, per i quali utilizziamo la rete di lavoro o 
la funzione "snap to object", che dipende dal pacchetto del programma. La connessione 
tra due punti può essere composta da una sola riga. Per correnti più elevate è necessario 
utilizzare VIA più grandi, che riducono l'impedenza e aumentano l'affidabilità. Tra i pad 
di connessione sulla distanza 100mil, diminuiamo la larghezza della linea. Le linee di 
alimentazione e di messa a terra devono essere più larghe per carichi di corrente più 
elevati. Le linee di alimentazione e di messa a terra devono essere impostate il più vicino 
possibile, il che può essere efficacemente bloccato da elementi di capacità. Non ci 
dovrebbero essere "isole" di rame senza connessioni. Queste isole devono essere fissate 
saldamento o eliminate. L'immagine 8 presenta diversi modi di collegare elementi. 
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                  a)                                                                         b)                                                    c) 

IMMAGINE 8: CONNESSIONI DEGLI STAMPATI: A) APPROPRIATE, B) APPROPRIATE, C) NON APPROPRIATE. 

 

Scegliere gli stampati 

Quando si scelgono i materiali per gli stampati, abbiamo diverse possibilità che 
differiscono in diverse caratteristiche, come ad esempio: sicurezza antincendio, stabilità 
della temperatura, assorbimento dell'umidità. Queste caratteristiche sono definite 
dall'associazione internazionale NEMA - National Electrical Manufacturers Association. 
La Tabella 4 presenta una panoramica dei materiali per la produzione di stampati. 

Materiale Commenti 

FR-1 Bachelite: a temperatura ambiente scarsa resistenza all'umidità. 
FR-2 Bachelite: adatto per PCB a strato singolo, buona resistenza 

all'umidità. 
FR-3 Resine epossidiche: un materiale bilanciato con buone proprietà 

meccaniche ed elettriche. 
FR-4 Fibre di vetro: eccellenti proprietà meccaniche ed elettriche. 
FR-5 Fibre di vetro: alta resistenza alle alte temperature, 

autoestinguente. 
G10 Vetro e resina epossidica: alta resistenza di isolamento, massima 

resistenza meccanica, elevata resistenza all'umidità. 
G11 Vetro e resina epossidica: resistente alla flessione ad alte 

temperature, estrema resistenza ai solventi. 
CEM-1 Carta di cotone e resina epossidica. 
CEM-2 Carta di cotone e resina epossidica. 
CEM-3 Non-tessuto e resina epossidica 
CEM-4 Tessuto di vetro e resina epossidica. 
CEM-5 Tessuto di vetro e poliestere. 
PTFE Pura - costosa, bassa perdita dielettrica, per applicazioni ad alta 

frequenza, assorbimento di umidità molto basso (0,01%), 
meccanicamente morbido. Difficile da laminare, usato raramente 
in applicazioni multistrato. 

RF-35 PTFE caricato con fibra di vetro rinforzato. Relativamente meno 
costoso, buone proprietà meccaniche, buone proprietà ad alta 
frequenza. 

Allumina Ceramica: dura, fragile, molto costosa, molto performante, buona 
conduttività termica. 
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Poliimmideide Un polimero ad alta temperatura: costoso, ad alte prestazioni, 
maggiore assorbimento d'acqua (0,4%). Può essere utilizzato per 
temperature criogeniche superiori a 260 ° C. 

TABELLA 4: TIPOLOGIE DI MATERIALI PER STAMPATI. 

L’etichetta FR siginifica materiale ritardante di fiamma. Lo spessore del 
rivestimento di rame su materiali stampati è di 0,5oz (18 μm), 1oz (35 μm) o 2oz (70 
μm). Esistono anche altri standard meno utilizzati (12 μm) e (105 μm). I materiali 
stampati con anima in alluminio o metallo hanno un rivestimento in rame da 70 μm a 
400 μm. Il materiale più utilizzato negli ambienti industriali è FR-4. Questo materiale è 
la scelta ottimale per quanto riguarda prezzo e causalità. 

Quando progettiamo stampati, scegliamo anche un numero di livelli. L'elevato 
numero di strati generalmente aumenta i costi di produzione, ma consente anche la 
produzione di stampati più piccoli e resistenti.  

• Scheda stampata su un lato: È adatto per circuiti a bassa frequenza semplici, 
come mostrato nell'immagine 9. Il circuito può essere prodotto con molti ponti. 
Tali circuiti hanno una resistenza peggiore ai disturbi elettromagnetici. La 
progettazione di circuiti complessi su un PCB a uno strato richiede molto più 
sforzo e innovatività. Solitamente, vengono utilizzati per i dispositivi pilota e per 
i primi test dei componenti. 

• Scheda stampata sui due lati: Spesso sono realizzati in materiale FR-4, 
come mostrato nell'immagine 10. Il circuito è più facile da collegare. Se 
possibile, la superficie inferiore è destinata alla messa a terra e altri 
collegamenti sono lasciati sulla superficie superiore. I vantaggi della 
superficie di messa a terra sono l'aumento della stabilità meccanica dei 
materiali stampati e l'impedenza ridotta di tutte le connessioni di messa 
a terra (riduzione del rumore). Aggiunge capacità distribuita a ciascuna 
connessione sullo strato superiore, che aiuta a prevenire i disturbi 
elettromagnetici. Agisce come uno scudo dal rumore elettromagnetico. 

• Stampe a più lati: Possono essere utilizzati 4, 6, 8, 10  fino a 38 strati. 
Questi sono più adatti per dispositivi ad alta frequenza sensibili. Il solito 
spessore di stampati fronte-retro è di 1,5 mm, il che è eccessivo. A una 
distanza minore tra lo strato superiore e quello inferiore, otteniamo una 
migliore capacità distribuita. È anche più semplice collegare 
l'alimentazione e le connessioni di messa a terra (alimentazione e strati 
di messa a terra). La connessione è facilmente realizzabile tramite VIA. 
Altre linee di segnale hanno molto spazio su tutti gli altri livelli, il che 
semplifica notevolmente la connessione. Maggiore capacità di 
distribuzione tra l'alimentazione e gli strati di messa a terra che riducono 
il rumore ad alta frequenza. Inoltre, blocca meglio i disturbi EMI / RFI. La 
produzione di materiale stampato multistrato è significativamente più 
costosa rispetto ai circuiti con meno strati. 
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IMMAGINE 9: SCHEDA STAMPATA SU UN LATO. 

 

IMMAGINE 10: SCHEDA STAMPATA SU DUE LATI. 

 

IMMAGINE 11: STAMPA A PIÙ LATI. 

 

11.3. Esempi di utilizzo del Programma Altium Designer 
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Programma Altium-Designer è un ambiente professionale per la progettazione di 
circuiti stampati in tutte le fasi, quali: 

• Progettazione di diagrammi di flusso e schemi a blocchi.  

• Progettazione di circuiti stampati-PCB. 

• Progettazione di software per FPGA (Field Programmable Gate Array). 

• Soluzioni di sistema per FPGA e debug (quando si lavora con schede di 
sviluppo appropriate, come Altium NanoBoard). 

• Progettazione di sistemi integrati. 

• Strumenti di simulazione per circuiti digitali e analogici. 

• Analisi della qualità del segnale. 

• Gestione dei processi di produzione di PCB. 
 

Altium include editor e interfacce di programma per tutte le fasi della 
progettazione di dispositivi elettronici. La scrittura e la modifica del codice del 
programma insieme alla traduzione avvengono all'interno dell'ambiente Altium 
Designer. Nel nostro caso, presteremo maggiore attenzione al disegno e alla 
progettazione del circuito stampato per un dispositivo elettronico. Il contenuto è 
progettato in modo da offrire una panoramica delle diverse fasi di progettazione del 
PCB. La prima fase di progettazione include un contorno dello schema elettrico. La 
seconda fase include la traduzione dello schema in circuito stampato. In questa fase, 
determiniamo le dimensioni del materiale stampato, la disposizione degli elementi e le 
connessioni. Nella terza fase, mostreremo come presentare gli stampati in un ambiente 
3D e le possibilità di utilizzarlo in altri programmi CAD. In questo caso, daremo 
un'occhiata al circuito del generatore attuale, visto nell'immagine 12. 

 

IMMAGINE 12: SCHEMA DEL GENERATORE DI CORRENTE. 

 

11.3.1 Creare un nuovo progetto 
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Per ogni nuovo materiale stampato, si consiglia di creare un nuovo progetto 
perché in un progetto sono stati salvati tutti i documenti e le impostazioni correlate al 
processo di progettazione. Il file di progetto xxx.PrjPCB è un file ASCII in cui sono scritti 
tutti i documenti e le impostazioni di output, come le impostazioni di stampa e CAM. I 
documenti che non sono correlati al progetto sono chiamati documenti gratuiti. 
Aggiungiamo anche collegamenti a schemi elettrici, PCB, FPGA, VHDL (linguaggio di 
descrizione dell'hardware Verilog) integrato e librerie. Quando il progetto è completato, 
tutti i disegni sono sincronizzati all'interno dei documenti nel progetto. Il progetto viene 
creato con il seguente set di comandi: 

• Scegliere File → Nuovo → Progetto → Progetto PCB, immagine 13. 

 

IMMAGINE 13: CREARE UN NUOVO PROGETTO. 

• Possiamo vedere la finestra  Progetti, dove il progetto 
PCB_Projects.PrjPcb viene elencato senza documenti allegati. 

• Rinomina il progetto, nel nostro caso Current_ generator.PrjPcb, in modo 
da salvarlo nella posizione su disco a nostra scelta con il commando 
successivo. File → Salva il Progetto come → Current_generator.PrjPcb. 

 

Quindi creare un nuovo file per la progettazione dello schema elettrico 
'schematico'. Crea nuovo schema.  

• Scegliere File → Nuovo → Schematico. Possiamo notare il file 
Sheet1.SchDoc che viene aggiunto automaticamente al progetto creato in 
precedenza, visto nell'immagine 14.  

• Rinomina lo schema Current_generator.SchDoc. Salvare lo schema, File →  
Salva come → Current_generator.SchDoc. 
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IMMAGINE 14: CREARE UNO SCHEMA DI CIRCUITO. 

 

Quando viene aperto uno schema vuoto, possiamo vedere una visualizzazione 

completamente cambiata con diversi tasti, menu, ecc. Ora siamo nell'editor per schemi 

elettrici. Se vogliamo aggiungere lo schema già delineato di un altro progetto allo 

schema creato, quindi scegliere Aggiungi l’esistente al Progetto. 

Prima di iniziare a progettare schemi elettrici, dobbiamo impostare quanto segue: 

• Impostazione del formato per foglio di lavoro: Design → Documento, Opzione – 

scegliere formato A4. 

• Il foglio di lavoro può essere ingrandito con una combinazione di tasto CTRL + 

rotella di scorrimento; la vista può anche essere adatta allo schermo intero con 

il comando Visualizza→ Adatta Documento [scorciatoia: V, D]. 

• Vi sono molte impostazioni alle quali è possibile accedere dal menu Strumenti 

→  Preferenze schematiche [scorciatoia: T, P], n cui le impostazioni 

influenzeranno tutti gli schemi nel progetto di lavoro.  

• Cliccare sullo schema e selezionare Default Primitives e attivare l’opzione  

Permanente, che offre valori preimpostati di base quando selezioniamo un 

elemento elettrico dalla libreria e non le impostazioni che abbiamo impostato 

nel passaggio precedente.  

La progettazione dello schema inizia con la scelta di un elemento, visto nell'immagine 

12. Nella libreria di elementi, cerchiamo tutti gli elementi, a partire dall'amplificatore 

operazionale MCP602. Altium ha un forte supporto per le librerie di componenti 

elettrici, come schemi, prese e modelli 3D. Queste librerie non sono ancora installate, 

ma possiamo scaricarle gratuitamente dal sito web di Altium 

(https://designcontent.live.altium.com/.) Se abbiamo una licenza valida. Possiamo 

anche scaricare librerie liberamente accessibili dal 2004 ed estendere la cartella in cui 

abbiamo già installato la libreria di base di Altium.  

Per cercare l'amplificatore corretto MCP602, fare clic su Librerie e poi Cerca (o 

cliccare su Strumenti → Trova Componenti) e quindi aprire la finestra di dialogo 

Ricerca Librerie.  
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Si deve prestare attenzione al fatto di aver selezionato tutti i componenti e 

cercare in modalità Librerie sul percorso in cui dobbiamo aver scritto il percorso corretto 

per le librerie installate. Per la maggiore possibilità di risultati durante la ricerca, non 

inserire tutti i segni, ma solo quelli principali perché diversi produttori hanno prefissi e 

suffissi diversi. Per fare ciò, inserire la stringa di ricerca tra due asterischi (nel nostro 

caso: * 602 *). Se scegliamo un componente dalla lista che non è ancora stato installato, 

allora abbiamo la possibilità di confermare che possiamo installarlo immediatamente 

oppure che può essere eseguito in uno step successivo. Per MCP602 è necessario 

installare in precedenza la libreria per produttore Microchip (Microchip Linear 

Devices.IntLib), quindi è disponibile MCP602, ed è possibile selezionarlo come mostrato 

nell'immagine 15.  

   

 

Per inserire, fare doppio clic sul componente che consente lo spostamento 

dell'elemento nell'area di lavoro con il cursore. Prima di spostarlo in un determinato 

luogo, possiamo modificare etichette e proprietà che possono essere attivate premendo 

il tasto Tab. Quindi nel campo Designatore inserisci un'etichetta componente che 

vedremo nello schema (nel nostro caso: U1A). Al controllo del modello, se il componente 

ha una presa corretta (nel nostro caso: SMD SOIC - 8 connettori). Una volta impostato 

tutto il necessario, si può iniziare con l'inserimento di componenti nello schema. Il 

componente può essere impostato sulla posizione desiderata facendo clic o premendo 

INVIO. Quindi sposta il cursore e vedi che con il prossimo clic possiamo inserire un altro 

OPA da cui l'etichetta U1A viene automaticamente aumentata a U1B, e altre proprietà 

preimpostate rimangono invariate. L'ambiente Altium consente l'inserimento multiplo 

di componenti dello stesso tipo che viene revocato dal tasto ESC.  

Nel prossimo passaggio inseriremo 7 resistori. Per l'inserimento, useremo una 

libreria di base che è installata in ambiente Altium sotto il nome Miscellaneous 

IMMAGINE 15: SCEGLIERE MCP602 DALLA LIBRERIA. 
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Devices.IntLib. Digitare *Res* nel motore di ricerca e quindi selezionare il resistore con 

socket SMD tipo 2010 etichettato come Res3. Selezionare il valore 25k che è il valore più 

comune e può essere successivamente modificato a determinati resistori. Reimpostare 

Designator sul valore più basso R1 e iniziare con l'immissione dei valori, come mostrato 

nell'esempio precedente. Quindi rinominare due resistori su Rref e Rb facendo clic su 

ciascuno separatamente e modificare il nome nel campo Designator, come mostrato 

nell'immagine 16.  

 

IMMAGINE 16: SCEGLIERE RESISTORE DALLA LIBRERIA. 

  Fare lo stesso con lo stabilizzatore di tensione LM336 (2,5 V, custodia TO92) 

della libreria ST-Electronics 'Power Mgt Voltage Reference.IntLib'condensatori (stringa 

di ricerca *Cap*) e terminali del connettore (stringa di ricerca *Header*) che si 

possono trovare nella libreria Miscellaneous Devices.IntLib, visti nell’immagine 17. 
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IMMAGINE 17: SCHELTA DEI TERMINALI  LM336, CONDENSATORI E DI CONNESSIONE. 

 

Quindi, disporre i componenti correttamente nello schema considerando gli input 
delle regole a sinistra e gli output nel sito corretto. Dobbiamo fare attenzione che ci sia 
abbastanza spazio tra i componenti per le connessioni perché se colleghiamo la 
connessione elettrica tramite i pin di connessione, il programma lo collegherà 
automaticamente con il connettore incrociato, immagine 18. 

 

IMMAGINE 18: DISPOSIZIONE DELL’ELEMENTO. 

 

Ai componenti esistenti, dobbiamo anche aggiungere potenziali di tensione, come 

messa a terra zero  e alimentazione elettrica  . . A scopo di test, inseriremo GND e 

alimentatore Vdd (inserirli in più punti per mantenere una migliore visibilità dello 

schema). Quando si collegano i componenti, è necessario considerare le seguenti 

regole: 
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• Abbiamo bisogno di avere una buona panoramica dello schema 
completo. 

• Disegnare connessioni con lo strumento  Posizionare il filo 
[scorciatoia: P,W]. Prestare attenzione alle interconnessioni per evitare 

cortocircuiti. 

• Se vogliamo spostare i componenti dopo averli collegati, dobbiamo 
eliminare le connessioni attuali, spostare i componenti e ricollegarli di 
nuovo. Possiamo anche utilizzare la combinazione CTRL + sposta con il 
mouse, che consente lo spostamento di componenti insieme alle 
connessioni precedentemente crea. 

Lo schema di cablaggio finito viene riportato nell'immagine 19.  

 

IMMAGINE 19: SCHEMA DI GENERATORE DI CORRENTE. 

Abbiamo anche bisogno di aggiungere ai nomi degli schemi di connessioni 
individuali (reti e etichette di rete) che possono essere successivamente utilizzati negli 
stampati. I nomi delle connessioni non sono essenziali per il funzionamento del circuito, 
ma servono come note o riferimenti durante la revisione del circuito finalizzato o per 
riparazioni successive. I connettori dei componenti sono collegati con le reti. Alcune 
connessioni con maggiore importanza e potenzialità nello schema elettrico possono 
essere nominate con il nome della nostra scelta. Usando i simboli per GND e Vdd 
abbiamo automaticamente impostato due nomi. Quando si sceglie Menu → Posiziona 
→ Net label [scorciatoia P, N] abbiamo la possibilità di impostare il nome su qualsiasi 
connessione. Premendo TAB, possiamo modificare le impostazioni, come colore, 
disposizione e tipo di carattere per l'etichetta di rete, prima di definire a quale 
connessione imposteremo il nuovo nome, come mostrato nell'immagine 20. 
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IMMAGINE 20: FINESTRA PER L’IMPOSTAZIONE DEL NOME DI CONNESSIONE, TIPO DI CARATTERE, COLORE, 
DIMENSIONE, ECC. 

 

Nel nostro circuito, useremo il nome del collegamento per la tensione di 

riferimento Vref mostrata nell'immagine 21.  

 

 

IMMAGINE 21: NOME DEFINITO PER LA CONNESSIONE VREF . 

 

Con questo, abbiamo finito di disegnare e progettare schemi elettrici, che sono la 

base per passare alla progettazione del circuito stampato. Prima di iniziare a tradurre lo 

schema in materiale stampato, si consiglia di configurare le impostazioni del progetto. 

Ciò include le impostazioni per il rilevamento di errori, matrice di connessione, 

generatore di classi, impostazioni per il comparatore, generazione di messaggi di avviso, 

impostazioni per la stampa, ecc. Altium usa tutte queste impostazioni quando traduce 

un progetto. Quando il progetto viene tradotto, vengono controllati il progetto 

completo e le regole elettriche impostate. Dopo aver risolto tutti gli errori, lo schema 

viene nuovamente tradotto e caricato nel progetto di destinazione, ad esempio con un 

documento PCB. Il comparatore di progetto consente di cercare le differenze tra i file di 

origine e di destinazione che vediamo e può essere confermato o rifiutato 

(sincronizzato) da entrambe le direzioni. Tutte le impostazioni sono disponibili nel menu 

Progetto → Opzioni Progetto. 
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11.3.2 Determinazione di stampati  

Dopo che lo schema di cablaggio è terminato e le impostazioni sono corrette, 
possiamo iniziare a tradurre lo schema di cablaggio in stampati. Nella fase della 
transazione, tutte le regole di progettazione degli schemi elettronici vengono verificate 
con il possibile rilevamento degli errori e l'opzione di riparazione. Per tradurre un 
determinato progetto Current_generator.PrjPcb si deve scegliere Progetto → Compila 
Progetto PCB. Al termine della traduzione, il messaggio del traduttore è visibile nella 
finestra del messaggio. Per accedere a questa finestra, dobbiamo scegliere Visualizza → 
Pannelli ambiente di lavoro → Systema → Messaggi. I documenti tradotti verranno 
registrati nella finestra Visualizza → Pannelli ambiente di lavoro → Design Compiler → 
Navigator, dove possiamo monitorare la struttura del documento, l'elenco dei componenti e i 
tipi di connessione (quando si fa clic sulla connessione possiamo anche vederlo con linee 
marcate nello schema). In caso di errori e traduzione non riuscita, questi eventi sono registrati 

nella finestra Messaggi di errore. Se la traduzione ha successo, possiamo passare a un nuovo 
documento in cui possiamo progettare stampati con lo schema elettrico dato. Innanzitutto, 
creiamo PCB vuoto. Il modo più semplice è utilizzare l'interfaccia PCB Board Wizard con la quale 
possiamo scegliere tra formati industriali standardizzati o dimensioni proprie. Più tardi queste 

impostazioni possono essere modificate. La procedura Guidata per la scheda PCB si trova 
nel menu File, che deve essere abilitato per essere visibile, come mostrato nell'immagine 22. 
Se la scelta del file non è abilitata, abbiamo una riga di scorciatoie per determinate funzioni nella 

parte inferiore destra della schema, e sotto la scheda Sistema, possiamo selezionare File.  

 

IMMAGINE 22: SCEGLIERE LE SCORCIATOIE PER I FILE. 

La preparazione dei documenti segue questi passaggi: 
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1. Innanzitutto fare click su PCB Board Wizard e nella seconda finestra selezionare le 

unità metriche Metric, immagine 23. 

 

IMMAGINE 23: WIZARD PER CREARE PCB.  

2. Nella terza finestra scegli tra I formati PCB. Si può scegliere  Custom e quindi 

inserire le dimensioni W = 40 mm, H = 30 mm. Per la designazione del bordo 

PCB, selezionare il tipo di linea Mechanical Layer1. 

3. Nelle prossime due finestre scegliere un numero di strati e il tipo di VIA che 

attraversano l'intero spessore del PCB.  

4. Quindi selezionare il tipo di componente che installeremo per lo più su PCB 

(SMD, PDIP, ecc., A seconda del socket) e su quanti lati. La maggior parte dei 

componenti sono montati in superficie e sono installati solo su un lato. 

5. Nella seguente finestra selezionare le impostazioni raccomandate per 

connessioni e VIA: 

a) Il più piccolo spessore di connessione = 0,25 mm 

b) La larghezza di VIA più piccola = 1 mm 

c) Il diametro di VIA più piccolo = 0,6 mm 

d) The smallest distance between connections = 0,25 mm 

L'immagine 24 presenta due finestre wizard per le impostazioni di materiale stampato. 
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IMMAGINE 24: PASSAGGI NELLE IMPOSTAZIONI DEGLI STAMPATI DA 2 A 5. 

 

Dopo aver creato con successo gli stampati, vediamo una finestra con le dimensioni 
selezionate. Per non avere lo sfondo della pagina bianca, rimuoverlo nelle impostazioni facendo 

clic Design → Board options → Display sheet. La visualizzazione PCB può essere regolata 

con il comando View → Fit board o scorciatoia [V,F], vista nell’immagine image 25. 

 

 

a)                                                                                            b) 

IMMAGINE 25: REGOLAZIONE VISUALIZZAZIONE STAMPATI A) CON BACKGROUND, B) SENZA BACKGROUND. 

 

Le dimensioni del PCB possono essere successivamente modificate. Il modo più 
semplice è disegnare la forma del telaio desiderata che può essere utilizzata per 
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determinare i bordi del PCB. Questo può essere fatto facendo clic su tutte le linee che 
definiscono i bordi PCB con il mouse e quindi selezionare la funzione dal menu Design 
→ Board Shape → Define from selected objects, per tagliare il PCB alla forma 
desiderata, immagine 26.  

 

IMMAGINE 26: FORMA PCB SU MISURA. 

 

11.3.3 Traduzione del progetto - Compilazione 

Come prima cosa andare nell'ambiente dello schema elettrico e tradurre Design 
→ Update PCB. Cliccare Validate Changes, dove viene verificata la probabilità di errore. 
Se tutto è corretto, ci saranno i segni di spunta di conferma in stato. Se le modifiche non 
sono corrette, dobbiamo tornare indietro, controllare i messaggi di errore e risolvere gli 
errori. Quando il controllo degli errori ha avuto successo, cliccare Execute Changes, che 
trasferisce componenti e connessioni al PCB nel progetto, immagine 27. 

 

IMMAGINE 27: CONTROLLO DELLO SCHEMA DURANTE LA COMPILAZIONE. 

 

Trasferimento di componenti su stampati PCB, immagine 28. 
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IMMAGINE 28: FORMA DI ELEMENTI PER STAMPATI. 

Dall'immagine 28 possiamo vedere che la disposizione degli elementi negli 
stampati dipende dal designer. In questo caso, è opportuno prendere in considerazione 
le linee guida e le istruzioni per una buona progettazione di stampati. Nella fase 
successiva segue la disposizione dei componenti agli stampati. I componenti sono 
disposti facendo clic sul componente e spostandolo nella posizione corretta (fare clic 
con il pulsante sinistro e premerlo mentre si sposta il componente). Rispettare i limiti 
del PCB. Con la barra spaziatrice possiamo ruotare il componente durante il 
trasferimento. Anche il testo collegato ai componenti può essere spostato allo stesso 
modo dei componenti. 

 

IMMAGINE 29: COMPONENTI DISPOSTI SU STAMPATI. 

 

L'ambiente Altium ha un supporto funzionale per la disposizione dei componenti 
più semplice. Diversi componenti possono essere allineati orizzontalmente, 
verticalmente, con diversi bordi o linea centrale. Possono anche essere allineati con 
spaziatura uniforme. È possibile accedere a queste funzioni se selezioniamo il gruppo di 
componenti, dove usiamo il tasto MAIUSCOLO o attorno ai componenti che vogliamo 
selezionare. Quindi fare clic con il tasto destro del mouse e scegliere Align → Align 
[abbreviazione: A, A] e contrassegna le funzioni desiderate sull'asse X e Y. Inoltre, 
quando selezioniamo uno o più componenti, possiamo spostarli con il mouse o utilizzare 
la combinazione di tasti: CTRL + MAIUSC e tasti freccia. Ciò significa che una 
combinazione di un tasto freccia e CTRL causa una mossa più piccola (schiocco griglia x 
1) nella direzione desiderata rispetto a quando premiamo entrambi i tasti CTRL + 
MAIUSC, che fa muovere i componenti per una distanza maggiore (schiocco griglia x 10). 

La connessione di elementi disposti può essere effettuata manualmente o 
automaticamente. Nella connessione manuale, abbiamo una visione migliore delle 
connessioni e il lavoro richiede più tempo. Il collegamento manuale viene spesso 
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utilizzato in documenti stampati di grandi dimensioni. Il collegamento automatico è 
generalmente più utile in circuiti meno complessi. 

 

Collegamento manuale di materiale stampato PCB 

Collegamento PCB manuale significa creazione di connessioni e VIA su stampati 
per collegare tutti i componenti presentati dallo schema elettrico. In modalità manuale, 
di solito progettiamo argomenti stampati più complessi, dove sono importanti molti 
aspetti del design, come l'influenza EMI, la progettazione di circuiti RF, i circuiti analogici 
e digitali combinati, l'elettronica di potenza combinata, i circuiti digitali / analogici, ecc. 
Molte volte il progettista deve decidere e accettare compromessi tra alcune parti del 
design. Nel nostro caso, faremo il collegamento manuale, anche se il circuito è semplice. 
Proveremo a disegnare la connessione del segnale sullo strato superiore, per il livello 
inferiore useremo la massa GND, cui accederemo tramite VIA e in alcuni casi con i pad 
di connessione (connettori P1 e P2 e riferimento U3). Le connessioni consistono in 
segmenti sequenziali. Ad ogni modifica inizia un nuovo segmento di connessione. 
Generalmente Altium consente la disposizione delle connessioni in verticale, 
disposizione orizzontale e con angolo di 45 ° (a impostazioni avanzate possiamo anche 
utilizzare le curve) per ottenere un risultato professionale finale.  

Useremo le impostazioni standard. Per prima cosa, sceglieremo la visualizzazione 
Top layer. Utilizzare l’abbreviazione L per raggiungere il menu View configuration, dove 
rimuoveremo il segno di spunta nel livello Bottom e confermeremo la modifica, vista 
nell'immagine 30.  

 

 

IMMAGINE 30: SCEGLIERE LO STRATO SUPERIORE STAMPATO . 

 

Connessione in corso con . Possiamo collegare solo quei componenti o connettori che 
sono interconnessi elettricamente nello schema, che è in ambiente PCB presentato da 
sottili linee rette tra i pad di connessione. Premendo il tasto CTRL e facendo clic su un 
determinato pad di connessione, possiamo facilmente controllare quali pad sono 
interconnessi. Quando creiamo una connessione tra due connettori, possiamo 
completarla con la funzione automatica Auto-complete. Questo può essere fatto 
facendo clic sul primo connettore e poi sul secondo e durante tale operazione premere 
CTRL e il tasto freccia>. La connessione verrà creata nel modo più breve tra entrambi i 
connettori. Questa funzione ha successo se il percorso è abbastanza semplice senza 
grandi ostacoli tra i due punti. Il secondo modo è usando il tasto INVIO quando le 
connessioni sono terminate gradualmente, con cui diminuiamo il numero di segmenti in 
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una connessione. Altium consente altri modi di collegamento manuale in cui è possibile 
premere SHIFT + R durante lo spostamento e selezionare tra diversi metodi: 

• Push – In questa modalità, la connessione proverà ad attraversare l'altro punto 
spostando le connessioni già stabilite e le VIA all'interno delle regole. 

• Walkaround – Il percorso verso il secondo punto sta cercando di trovare 
disegnando la connessione intorno agli ostacoli senza spostare le connessioni e 
le VIA esistenti.  

• Hug & Push – Questa modalità è una combinazione di quelli precedenti.  

• Ignore – Questo metodo consente di stabilire connessioni ovunque senza violare 
le regole.  

Dobbiamo anche essere consapevoli dei componenti che impostiamo sulla 
superficie superiore, dove sono anche le connessioni del segnale e quelle che hanno i 
pad di connessione instradati attraverso il PCB sull'altro lato. Tali componenti sono 
saldati di seguito, quindi è necessario collegarli con connessioni di segnale sul lato 

superiore con VIA. Le VIA possono essere trovate con il tasto Luogo tramite . Poiché 
useremo lo strato inferiore per la massa, verranno installati i VIAs ai connettori P1, P2 e 
il riferimento. 

 Oltre ai componenti e ai VIA, è anche utile prevedere in che modo il PCB sarà 
collegato all'alloggiamento perché di solito abbiamo bisogno di fori per le viti. Quelli 

possono essere creati selezionando Place Pad . Non collegarlo a nessuna connessione 
elettrica. Segna l'opzione Placcato, quindi non ci saranno messaggi di errore più avanti 
durante il controllo del PCB.  

 

Ora dobbiamo riempire il lato inferiore degli stampati con la massa GND. Questo può 

essere ottenuto facendo clic sul pulsante  Place Polygon Plane dalla casella degli 
strumenti, impostare le sue caratteristiche e quindi definire i limiti del poligono 
disegnandoli in PCB, come mostrato nell'immagine 32 e 33.  

IMMAGINE 31: MATERIALE STAMPATO COLLEGATO. 
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IMMAGINE 32: DETERMINAZIONE DEL POLIGONO PER LA MESSA SULLA PARTE INFERIORE DELLO STAMPATO. 

 

IMMAGINE 33: STAMPATO CON LA MASSA AGGIUNTA GND SULLA PARTE INFERIORE. 

Routing automatico 

PCB più semplici e meno complessi possono essere collegati con un regime 
automatizzato in cui tutte le regole sono rigorosamente soddisfatte. Nel nostro caso, 
vogliamo una linea di segnale sul lato inferiore e il lato inferiore del PCB da riservare 
al poligono GND. Per questo, abbiamo bisogno di regolare le impostazioni, quindi le 
connessioni saranno solo sul lato superiore. Questo può essere fatto nelle regole. 
Design → Rules e in Routing Layers abilitiamo solo Top Layer, immagine 34. Poi 
selezionare dal menu Auto Route → All e cliccare Route All. 

 

 

IMMAGINE 34: SCELTA DELLO STRATO SUPERIORE PER IL COLLEGAMENTO AUTOMATICO TRA COMPONENTI. 
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IMMAGINE 35: RISULTATO DEL COLLEGAMENTO AUTOMATICO. 

A prima vista, il risultato è simile, ma i dettagli inseriti manualmente fanno la 
differenza. Ci sono alcuni errori che possiamo trascurare negli stampati. Inoltre, non è 
considerato che i componenti che sono saldati sul lato inferiore del contatto elettrico 
solo sul lato inferiore, quindi devono essere collegati con connessioni con VIA sul lato 
superiore. Le VIA sono benvenute alle connessioni GND perché possiamo renderle più 
breviSe ci colleghiamo automaticamente, è ragionevole usare i gruppi di connessione 
Net classes. Questi possono essere impostati tramite l'interfaccia utente Design → 
Classes. Qui possiamo aggiungere gruppi andando sulla scheda Net classes e facendo 
clic con il tasto destro del mouse su choose Add class. Possiamo vedere una finestra in 
cui tutte le connessioni elettriche disponibili sono scritte nella colonna Non-members e 
sulla destra c'è lo spazio dove possiamo aggiungere la connessione desiderata / 
contrassegnata con un clic sulla freccia. 

 

  

 

 

IMMAGINE 36: AGGIUNTA GRUPPI DI CONNESSIONE. 

Visualizzazione 3D  

La visualizzazione 3D consente di vedere PCB nello spazio da tutti i punti di vista. 

Possiamo alternare le visualizzazioni 1, 2 e 3. Il numero 3 è una scorciatoia per la vista 

3D, vista nell'immagine 37.  
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IMMAGINE 37: VISUALIZZAZIONE 3D DI STAMPATI. 

 

• Nella vista 3D possiamo usare le seguenti scorciatoie: 

• Zoom in: CTRL + scorrimento del mouse 

• Spostandosi su / giù: rotella del mouse, spostandosi a sinistra / a destra: 

MAIUSC + scorrimento del mouse 

• Rotazione: MAIUSC + tasto destro del mouse e trascina nella direzione 

desiderata che può essere selezionata sulla sfera con le frecce.  

Altium consente l'importazione di oggetti 3D da diversi strumenti CAD nel formato * 

.step *. È anche possibile esportare in formati, quali: step, dwg / dxf. Gli oggetti 

esportati possono essere utilizzati in altri programmi CAD che supportano i formati 

menzionati. 

Documentazione finale 

La documentazione finale o di esportazione può essere suddivisa in 5 gruppi: 

1. Elenco delle parti 

a. Piani per la disposizione automatica dei componenti robotici. 

b. Piani per il posizionamento dei componenti su entrambi i lati del PC. 

2. Documentazione di output 

a. Piani componenti inclusi collegamenti in rame. 

b. Visualizzazione 3D del PCB. 

c. Visualizzazione schematica di circuiti elettronici. 

3. Documentazione per la produzione di stampati 

a. Composite Drill Drawings - piani per i fori, la loro posizione e le 
dimensioni, tutto in un unico piano. 

b. Drill Drawing / Guides - progetta fori e istruzioni per la realizzazione, la 
loro posizione e le dimensioni in disegni separati. 

c. Stampe di disegni finali - in un unico piano ci sono molte informazioni 
di output differenti. 

d. File Gerber: file Gerber, creati separatamente per ciascun livello PCB. 

e. NC Drill Files - per controllo numerico (CNC) di trapani. 
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f. ODB ++ - Creazione di datasocket per produttore in formato ODB ++, 
socketd su C ++. 

g. Power-Plane Prints: piani per livelli interni e separati. 

h. Stampe di saldatura / incolla: progetta per i livelli protetti. 

i. Rapporto del punto di prova - rapporto sui punti di prova.  

4. Netlist Outputs – elenco di connessioni  

a. Le liste presentano la logica che collega tra componenti (in diversi 

formati di testo, CSV (valori separati da virgola). 

5. Report di output 
a. Distinta base: elenco dei materiali necessari per la realizzazione del 

circuito elettrico. 

b. Rapporto di riferimento incrociato dei componenti - elenco dei 

componenti basato sullo schema elettrico. 

c. Report Project Hierarchy: elenco di tutti i documenti. 

d. Segnala reti con pin singoli: elenco delle connessioni con un solo 

connettore. 

 

6. Documentazione per esigenze di produzione  

Nell'ultima fase, abbiamo bisogno di consegnare tutti i documenti necessari al 
produttore di PCB che sono necessari prima di realizzare PCB. Per questo, abbiamo 
bisogno di inviare file di drill Gerber e NC e lista dei materiali.  
 

Salvare i file Gerber – Ogni file Gerber corrisponde a un layer di materiale stampato 
con tutti i possibili profili di linea (sovrapposizione di componenti, livelli di segnale, 
strati di mascheratura di saldatura, ecc.). Prima di inviare e salvare i file Gerber, si 
consiglia di consultare il produttore per essere unificati con i loro requisiti.  


